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  مبانی
  یک کیلو بایت معادل چند بایت است؟-1

  بایت16)د    بایت           8)ج  بایت         1024)ب*بایت             2)الف  
  براي تایپ علائم بالاي کلید کدام کلید را باید پایین نگه داشت؟ درصفحه کلید-2

   Alt)د            Caps lock)ج                Ctrl)ب            Shift)الف*  
  سخت افزار چیست؟-3

  دستور العملها یک کامپیوتر )ب      اي فیزیکی وقابل لمسزاج)الف*  
  اي بیرونی یک کامپیوترزاج)د       اي جانبی یک کامپیوترزاج)ج  

  به دوایر متحدالمرکزروي سطح دیسک چه می گویند؟-4
  سکتور)د   استوانه                    ) ج    شیار          )ب*  قطاع         )الف  

  سرعت دسترسی به اطلاعات درکدام یک از حافظه هاي زیرسریع تراست؟-5
  RAM)د*هارد دیسک                   )ج    دیسکت ها     )ب            CD)الف  

6-CPUداراي چه قسمتهایی است؟  
  واحد کنترل-واحد محاسبه ومنطق)ب      پردازشگر-محاسبه ومنطق)الف  
   ثباتها-واحدکنترل-واحدمحاسبه ومنطق)د*        واحدخروجی-واحد ورودي)ج  

  کدام گروه از دستگاههاي زیرجزءدستگاههاي خروجی هستند؟-7
  صفحه کلید-ماوس-رسام)ب        چاپگر-ماوس-مانیتور)الف  
   ماوس- چاپگر-رسام) د         مانیتور-چاپگر-رسام)ج*  

  چیست؟LCD وCRTتفاوت مانیتورهاي -8
  هاازدیودهاي کریستال مایعLCDه کاتدي استفاده می کننداماازلامپ اشعCRTمانیتورهاي )الف*  
  به این کارت نیازندارندLCDبه آداپتورکارت نمایش نیازدارندولی مانیتورهاي CRTمانیتورهاي ) ب  
   رنگکبه صورت تLCDبه صورت رنگی وتک رنگ تولیدمی شوندولیCRTمانیتورهاي ) ج  
  حجم بسیارزیادي برخوردارهستنداز CRTنسبت به مانیتورهايLCDمانیتورهاي) د  

   از قسمتهاي کامپیوتر بر فعالیت واحدهاي دیگرنیز نظارت دارند؟ککدام ی-9
 CU)د*                         OU)ج                      IU)ب               ALU)الف  

  عامل نمی باشد؟سیستم کدام گزینه -10
 Linux)         دPower Point)ج*                    Dos)             بWindows)الف  

  شبکه داخل یک کلاس درسی جزء کدام یک ازشبکه میباشد؟-11
  LAN) د*                      MAN)                  جWAN)ب               Internet)الف  

  کدام مورد است؟ICDLمعنی استاندارد-12
  ن المللی کاربري کامپیوترمدرك بی) ب*    مدرك بین المللی کامپیوتر)الف  

  مدرك اپراتوري ویندوز)مدرك بین المللی کاربري ویندوز                 د)  ج    
  دي نمی باشد؟وروکدام یک از ابزارهاي زیرجزءوسیله هاي -13

  Speaker)د*                    Joy stick)            جMouse)             بMicrophone )الف  
   از مزایاي شبکه محسوب نمی شود؟ یککدام-14

  قابلیت اطمینان بالااز طریق داشتن منابع متعدد)ب       به اشتراك گذاشتن منابع)الف  
  خرابی وفرسودگی سیستم ها ي موجود درشبکه)د*    دسترسی به برنامه وداده ها براي کلیه کاربران)ج  

  هدچه می گویند؟به کامپیوتري که در یک شبکه به کامپیوترهاي دیگر سرویس د-15
  Work station)                 دSever)ج*                        Client)ب              Node)الف  

  .واحد مناسب عملیات ریاضی ومنطقی نامیده می شودCPUکدام یک از بخشهاي -16
  cache)د               register) ج                 ALU)ب*             cu)الف  
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  .استفاده می شود چه نامیده می شود هاه تعبیه واز آن براي بالا بردن سرعت دسترسی به دادramوCPUافظه اي که بین ح-17
  hard) د              EPROM)ج           cache)ب*             ROM)الف  

   0آدرس هر منبع در اینترنت چه نامیده می شود-18
 Telnet) د                  ETP)ج              https)ب     url)الف*  

  0می باشدنکدام یک از موارد زیر جزء نرم افزارهاي کاربردي -19
 Microsoft word XP)ب                   Microsoft windows XP)الف*  

 Microsoft Excel XP) د                 Microsoft power point XP )ج  

  0 نمی شودکدام یک از موارد زیر سیستم عامل محسوب-20
   Google Mail)ب*                         Google Android )الف  
   Windows NT)د                                  windows7)ج  

  0خواهد بود...........بیش تر از ویندوز........طول عمرباتري لپ تاپ ها باسیستم عامل -21
  windows7 -ویستا)ب     ویستا                       - windows7)الف*  
  یونیکسwindows7- )لینوکس                         د Windows NT-)ج  

مجموعه اي از برنامه هاي رایانه اي وداده هاي مرتبط است که دستوراتی را براي مشخص کردن این که یک رایانه چه کاري راانجام -22
  0می گویند............دهدرا

  میان افزار)د    نرم افزار       )ج*  سیستم عامل        )ب   سخت افزار       )الف  
23-ICT است...............به مفهوم.  

  information and connections )ب   information and connections technology)الف  
  information and communications technology  )دinformation and communications technology       )ج*  

   کدام یک از گزینه هاي زیر یک سرویس اینترنتی براي کاربران نیست؟ -24
  برق الکترونیک)د*  دولت الکترونیک   )ج  بانکداري الکترونیک    )ب  نیک      وتجارت الکتر)الف  

  .کاهش آلودگی هاي زیست محیطی می شود کدامیک از مواردزیر باعث-25
  ملاقات وجلسات حضوري)ب    نیکی به جاي اسنادکاغذي واستفاده از اسناد الکتر)الف  
  رایانه)Stand by(استفاده از حالت مصرف برق کمتر)د*       بازیافت کاغذها وتونرهاي مصرف شده)ج  

  .امیک از موارد زیردر سازمان ها،موسسات پیشرفته وجوامع علمی ،به عنوان شاهرگ حیاتی محسوب می شوددک-26
  مدیران)د    اطلاعات   )ج*توانمندي هاي کارمندان    )    بتجهیزات کامپیوتري )الف  

  .در دیسک هاي نوري براي خواندن ونوشتن اطلاعات از چه چیز استفاده می شود-27
 xاشعه )د  اشعه مادون قرمز   ) ج    اشعه لیزر  )ب*  اشعه ماوراي بنفش   )الف  

ایشی ورایگان از آن استفاده می کند ولی بعد از مدتی غیر قابل استفاده می به نرم افزاري که مصرف کننده براي مدت مشخصی به طور آزم-28
  می گویند.........شود،نرم افزار

  Open Source)د            Share)ج*          Demo)ب           Free Ware)الف  
  ظرفیت کدام یک از حافظه ها ي زیر بیشتر است ؟ -29

   Eerom -د     Eprom-ج  حافظه هاي ثانویه -ب*     Ram –الف   
  ؟ نیست زیر به امور سلامتی هنگام کار با کامپیوتر مربوط  کدام یک از عبارت هاي-30

   اطمینان از مناسب بودن نور اتاق -ب     اطمینان از تنظیم بودن ارتفاع صندلی -الف  
   گاهی نگاه کردن به یک نقطۀ دور -د        ذخیره کردن مرتب کار -ج*  

   به کامپیوتر چیست ؟ مزیت انسان نسبت-31
   انجام محاسبات با سرعت بالا-ب      محاسبات با دقت بالا  انجام -الف  
   قابلیت اطمینان -د         خلاقیت وابتکار -ج*  
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  بهترین راه براي جلوگیري از سرایت ویروس به سیستم کامپیوتري چیست ؟-32
    شتن یک ویروس یاب که توانایی به روز شدن را داشته باشد  دا-ب*  ی ق بررسی نامه هاي الکترونیکی داراي فایل الصا-الف  
  ... وکول دیسک وcd استفاده از حافظه هاي جانبی مثل -د         اتصال به اینترنت-ج  

  از کدام مورد براي چاپ نقشه ها وتصاویر بزرگ استفاده می شود ؟-33
  اي تکثیر  ماشین ه-د   دستگاه هاي فتوکپی -ج     پرینترها-ب     پلاترها -الف*  

  دارد ؟ بزرگترین شبکه موجود در جهان که از تجهیزات مخابراتی استفاده می کند چه نام-34
   اینترانت -د   INTERNET-ج*    MAN-ب     LAN -الف  

   کار کنترل و نظارت داده هاي ورودي وخروجی را بعهده دارد ؟CUPکدام واحد -35
   CACHE-د      ALU-ج     REGISTER-ب     CU-الف*  

  .... با خاموش شدن کامپیوتر ROMاطلاعات حافظه -36
  . پاك نمی شود-د*  . به حافظه اصلی منتقل می شود-ج  .پاك میشود -ب   میرود CUP به -الف  

  : باشد یعنی MB 1اگر  ظرفیت حافظه اي -37
  ت  بای50 به توان 2 -د   بایت 40 به توان 2 -ج   بایت 20 به توان 2 -ب*   بایت 10 به توان 2 -الف  

  رایج ترین دستگاه خروجی کدام است ؟-38
   هارد دیسک -د      پرینتر-ج    مانیتور-ب*     پلاتر-الف  

  گویند؟.....ونیکی ربه مجموعه اي از عناصر قابل لمس و فیزکی و مدارهاي الکت-39
  نرم افزار)د    سخت افزار)ج*    ترانزیستور)ب    )IC(تراشه )الف   

  امپیوتر کجاست ؟محل قرار گیري دیسکهاي سخت در ک-40
   هارد دیسک -د      پرینتر-ج     CASE-ب*   MOTHER BORD -الف  

   از چه چیزي استفاده می شود ؟EEPROMبراي پاك کردن -41
   مادون قرمز -د     تکنولوژي نانو -ج   اشعه ماورا بنفش -ب   جریان الکتریسیته -الف  

   در کدام نوع از حافظه قرار داده می شود ؟ BIOSبرنامه -42
   SRAM-د     DRAM-ج     RAM-ب     ROM -الف*  

  کدام گزینه درست است ؟-43
  . همه حافظه هاي ثانویه خواندنی و نوشتنی هستند-ب      . کمتر از حافظه اصلی است HARD حجم -الف  
  ی  حافظه هاي اصلز سرعت حافظه هاي ثانویه بیشتر ا-د  . با قطع جریان برق از بین می رود RAM اطلاعات حافظه -ج*  

44-It یعنی:  
  ارتباطات مخابراتی) د   فناوري کامپیوتر) ج  فناوري اطلاعات) ب*  فناوري اطلاعات و ارتباطات) الف  

45- ICT ؟................ مخفف  
  Internet Communication) ب   Information Communication Technology) الف*  
 International Communication Technology ) د       Information Computer Technology) ج  

  است؟. …و تبدیل آنها به . …هدف از پردازش داده ها  دریافت  -46
  داده ها، واحد خروجی ) د  داده ها، اطلاعات مفید ) ج*  اطلاعات ، دستورالعمل ها ) ب  اطلاعات مفید، داده   ) الف  

47- IT ؟ ............................  مخفف  
   Internet Technology) ب    Information Technology )الف*  
     Information Training) د    International Training) ج  

  ها؟  نتایج حاصله از پردازش داده-48
  )ورودي (Input) د  ) پردازش (Processing) ج  ) اطلاعات (Information) ب*   )داده (Data) الف  

   بانک اطلاعاتی می باشد؟کدام گزینه زیر یک نرم افزار-49
 Access)د*   Excel)ج   Power point) ب   Word) الف  

  تدریس  می شود؟» صفحه گسترده «  کدام نرم افزار به عنوان ICDL در مهارت هاي هفتگانه - 50
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  MS-Access)د MS_EXCEL)ج*    Outlook express)ب MS_WORD)الف  
  کار می رود؟کدام نرم افزار براي طراحی و نقشه کشی به -51

  )AutoCAD(اتوکد) د*    )Excel(اکسل)ج  )  Word(واژه پرداز)ب  )Photoshop(فتوشاپ)الف  
  کدام یک از موارد زیر سخت افزار نمی باشد ؟-52

  سیستم عامل) د*    فلاپی دیسک) ج   کارد گرافیکی    )ب  برداصلی یا برد مادر) الف  
   تعریف نرم افزار کدام گزینه زیر است؟-53

  حافظه ها) د  داده ها و دستورالعمل ها ) ج*  قطعات غیر فلزي  ) ب   اجزاي قابل لمس)الف  
54-Personal computerجزء کدام دسته از رده هاي زیر می باشد؟   

  Super computer)د  Main frame computer )ج   Mini computer)ب   Micro computer)الف*  
   کدام کامپیوتر زیر، قوي تر است؟-55

  Micro computer )ب         Mini computer )الف  
   Main frame computer )د     Super computer  )ج*  

  کدام گزینه  زیرکامپیوتر کیفی محسوب می شود ؟-56
   Pc)  د  Desktopکامپیوتر )ج    Notebook)ب*  Main frame )الف  

  کدام دستگاه زیر براي انتقال تصاویر در اینترنت به کار می رود؟ -57
  قلم نوري) د    پویشگر ) ج      دستگاه رقمگر ) ب    وب کم ) الف*  

  جزء کدام رده از  کامپیوتر هاست؟ ) Pc(کامپیوترهاي شخصی -58
  ابرکامپیوترها ) د     ریز کامپیوترها)ج     کامپیوترهاي کوچک ) ب    کامپیوترهاي بزرگ ) الف*  

  کدامیک از دستگاه هاي زیر فقط خروجی است؟-59
  ماوس)د    دیسکت)ج      اسکنر)ب    مانیتور)الف*  

  کدام یک از دستگاه هاي زیر جهت انتقال تصاویر به کامپیوتر به کار می رود؟-60
  ماوس)د    صفحه کلید)ج      پلاتر)ب    اسکنر) الف*  

  روش کار چاپگرها چیست؟-61
  الف و ب) د*     حرارتی)ج    غیر ضربه اي)ب    ضربه اي)الف  

  :وري و رسام به ترتیب و قلم ن) اسکنر( پوینده -62
  .دستگاه خروجی، دستگاه ورودي ودستگاه خروجی هستند) ب  .دستگاه ورودي، دستگاه ورودي ودستگاه خروجی هستند) الف*  
  .هرسه ورودي هستند) د  . دستگاه خروجی ، دستگاه ورودي ودستگاه ورودي هستند) ج  

  کدامیک از گزینه هاي زیر یک  دستگاه ورودي است؟-63
  رسام)د    صفحه نمایش)ج     بلندگو)ب    دسته بازي)فال*  

  کدام یک از گزینه هاي زیر دستگاه ورودي و خروجی محسوب می شود؟-64
  بلندگو) د  CDدیسگ گردان ) ج    میکروفون) ب  صفحه نمایش لمسی)الف*  

  کدام چاپگر زیر غیر ضربه اي است؟-65
  جوهر افشان) د*             چرخ آفتابگردان) ج    زنجیري) ب  ماتریس نقطه اي) الف  

   بهترین نوع چاپگر از نظر سرعت و کیفیت کدام است؟-66
  حرارتی)د            جوهر افشان)ج    لیزري)ب*  ماتریس نقطه اي)فال  

   قلم نوري و ماوس چه دستگاه هایی هستند؟-67
   خروجی-وديور) د   ورودي      -ورودي) ج*   ورودي     -خروجی)  خروجی           ب-خروجی) الف  

  نیست؟ کدامیک از وسایل زیر جزء وسایل ورودي -68
  پرینتر) د*            ماوس) ج         اسکنر   )  ب    صفحه کلید) الف  

   کدام گزینه زیر وسیله لازم براي ارسال و دریافت داده به کار می رود؟-69
  قلم نوري) د            اسکنر) ج         مودم   ) ب  *    ماوس) الف  
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  هاي زیر خروجی نمی باشند؟ کدامیک از دستگاه -70
  مانیتور)د             پلاتر) ج                اسکنر) ب*    پرینتر ) الف  

  د زیر سخت افزار نیست؟ر کدامیک از موا -71
  کارت گرافیک ) د          سیستم عامل ) ج*         فلاپی دیسک ) ب    هارد دیسک ) الف  

  اندازي سیستم توسط سازندگان کامپیوتر در کدام حافظه ذخیره می شود؟اطلاعات لازم براي راه -72
  Register)د            Hard) ج   Rom)ب*   Ram)الف  

  ظرفیت کدام حافظه از بقیه حافظه ها بیشتر است ؟-73
  Cd)د              Floppy)ج     Hard)ب*    Ram)الف  

  کدام حافظه جزء حافظه فرار می باشد؟-74
  Ram) د         *   Floppy) ج            Hard )ب     Rom)الف  

  کدام گزینه زیر کوچکترین واحد اندازه گیري حافظه است؟-75
  کیلو بایت)د          Word) ج            بایت)ب    بیت) الف*  

   فلش دیسک ها جزء کدام حافظه محسوب می شوند؟-76
   حافظه داخلی هارددیسک  )د    یزپردازندهر حافظه داخلی  )ج  حافظه هاي جانبی )ب*   حافظه هاي اصلی)الف  

  گفته می شود؟...........  بیت مجاور هم که یکی از علایم یا اعداد یا حروف را نمایش می دهد 8 به مجموعه -77
  Bit) د                  Byte) ج*              Word)             ب    File) الف  

   کیلو بایت است؟……، یا  Mb4 حافظه اصلی یک سیستم کامپیوتري -78
  4096) د*               4028) ج     4024) ب     4000) الف  

  کدامیک از حافظه هاي زیر سرعت بیشتري دارد ؟-79
  Dvd)د          Hard)ج      Cd)ب   Ram)الف*  

  در مدارات الکترونیکی چیست؟) Binary( علت استفاده از سیستم مبناي دودویی -80
  دو حالته بودن این مبنا )ب    .شود ازي مدارات آسان تر انجام میطراحی و پیاده س)الف  
  همه موارد)د*        محاسبات راحت تر عملیات)  ج  

   هر کیلو بایت معادل چند بایت است؟-81
   بایت1000) د     بایت 1024) ج*     بایت 128) ب     بایت 512) الف  

   کند؟تواند ذخیره بایت هارددیسک چند کاراکتر را می چهل گیگا-82
  4×233)د    40×240)ج    40×230)ب*    40×220)الف  

  ظرفیت فلاپی دیسکها جند مگابایت می باشد؟-83
  700) د      256) ج      5/2) ب    44/1) الف*  

   حافظه هاي زیر الکترونیکی هستند؟کدامیک از-84
  Floppy)د  Harddisk)ج   Ram)ب*   Dvd)الف  

   کدامیک از حافظه هاي زیر جانبی هستند؟-85
  Cache)د  Ram)ج     Cd)ب*   Rom)لفا  

86-Ram است؟. ……… یک حافظه  
  تنها ماندنی ) د    موقت ) ج*    دایمی ) ب    جانبی ) الف  

  رود؟  کدام حافظه زیر براي ذخیره دایمی حجم زیاد اطلاعات به کار می-87
  )ثبات(رجیستر) د               فلاپی)  ج     هارددیسک  ) ب*  RAM) الف  

  جهت بالا بردن سرعت انتقال اطلاعات به کار می رود؟  قرار می گیرد و RAMو  CPU  که بین حافظه اي-88
  حافظه کمکی ) د     Rom) ج    Register) ب    Cache) الف*  

  :عبارتند از Cpu اجزاي تشکیل دهنده -89
  Alu – Cu – Out Put) ب       Alu- Input Unit – Cu) الف  
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   ثبات یا ریجستري – Alu- Cu) د*        حافظه اصلی– Alu – Cu) ج  
  کدام قسمت ازکامپیوتر وظیفه انجام محاسبات را برعهده دارد ؟-90

  ALU) د*    هارددیسک) ج    ROM)ب  RAM)الف  
  :باشد نمی CPU کدامیک از اجزاي زیر متعلق به -91

 Ram) د*  Register) ج        Cu) ب  CPU) الف  
  کدام مورد زیر استفاده می شود ؟ تلفنبراي ارتباط با اینترنت از طریق خط -92
   Mpegکارت )د    کارت مودم    )ج*    کارت مایرو   )کارت شبکه                  ب)الف      
  برنامه هایی که اجرا می شوند قبل از پردازش در کدام حافظه قرار می گیرند؟-93

  )ثبات (Register) د   Ram) ج*   Rom) ب  Floppy) الف  
  ه زیر فقط یک بار توسط کاربر قابل برنامه ریزي می باشد؟کدام حافظ-94

  ROM) د   EEPROM) ج    EPROM) ب  PROM) الف*  
  کوچکترین عنصر تصویر چه نامیده می شود؟-95

  Kilo Byte)د    Pixel)ج*    Byte)ب     Bit)الف  
  فزار به کدام دو دسته زیر متعلق است ؟ به طور کلی هر نرم-96

   تجاري -سیستمی  ) د  کاربردي    -سیستمی ) ج* کاربردي    -برنامه نویسی) ب     سیستمی  –شبکه ) الف  
   سیستم عاملی که هم زمان چند نفر می توانند با آن کار کنند چه نام دارد؟-97 

  مترجم ) د     چند کاربره  ) ج*    چند کاره  )  ب  برنامه سودمند  ) الف  
   انواع نرم افراز سیستمی شامل؟-98

   مترجم- کمکی یا سودمند-سیستم عامل) ب*        مترجم            - سیستم عامل- کاربردي)الف  
   مترجم-پرداز  واژه-کاربردي)  د      کاربردي   )  کمکی یا سودمند-سیستم عامل) ج  

  شبکه ها از نظر فواصل به چند دسته تقسیم می شو ند؟-99
  Star و Wan و LAN)ب     Man وLAN و Wan)الف*  
  Star و LAN و Ring)د       Ring و Star و Bus)ج  

  کدام یک از شبکه هاي زیر براي فواصل کم به کار می رود؟-100
   Internet )د   Man)ج   Wan)ب  LAN)الف*  

  چه گفته می شود؟  به کامپیوتري که در یک شبکه به دیگرکامپیوترها سرویس می دهد-101
  word station) د          Server) ج*    Node) ب   Client) الف  

  کدامیک در مورد ویروس درست است؟-102
  یک برنامه مستقل است) د  قابلیت تکثیر دارد)ج*  جزء سخت افزار است   )ب   آشکار و مستقل است،حجیم) الف  

   علت وجود ویروس در یک کامپیوتر باشد؟تواند نمی کدامیک از علایم زیر -103
  روشن نشدن سیستم) د*     شدن غیرمنتظره سیستمReboot) ج  ت سیستمکاهش سرع) ب  خاموش شدن سیستم) الف  

  ویروس ها چگونه سیستم را آلوده می کنند ؟-104
  قرار گرفتن در جدول پارتیشن) ب      آلوده کردن قطاع بوت کننده ) الف  
  همه موارد فوق ) د*      چسبیدن به فایل هاي اجرایی ) ج  

105-CPU شوداطلاق می.........  به واحد .  
  حافظه)د          محاسبه ومنطق)ج     کنترل)ب  پردازشگر مرکزي    )الف*  

  نیست؟کدام یک از گزینه هاي زیر جزء مشخصه یک کامپیوتر -106
  اشتباه نمی کند)داراي تفکر است          د)ج*  پردازشگر است     )ب  داراي حافظه است   )الف  

  واحد سرعت ریز پردازنده چیست؟-107
  بیت در ثانیه)             د  گیگاهرتز) ج*       مگابایت) ب          انوثانیهن) الف  

   مهم ترین نرم افزار سیستمی کامپیوتر چه نام دارد؟-108
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  Compiler ) د  Operating system)ج*    Utility)بPeresentation    )الف  
  برنامه حسابداري جزء کدام نرم افزار محسوب می شود؟-109

  مترجم) د    سودمند) ج    کاربردي) ب*    سیستمی) الف  
   کدام گزینه زیر براي تبدیل زبان سطح بالا به زبان ماشین به کار می رود ؟-110

  سیستم عامل)د  زبان برنامه نویسی)ج     Cpu)ب    ه مترجمبرنام)الف*  
   فاصله مانیتور از پیشانی باید چند سانتی متر باشد؟-111

  70 الی 55) د    40 الی 20) ج    45 الی 30) ب    55 الی 45) الف*  
  ارتفاع میزکامپیوتر حدوداً چندسانتی متر می باشد؟-112

  71 تا 66) د*    90 تا 76) ج    65 تا 45) ب    60 تا 50) الف  
  اینترنت جز کدام شبکه محسوب می شود؟-113

  الف وب) د     شهري) ج    گسترده) ب*    محلی) الف  
  یات ریاضی و منطقی نامیده می شود؟واحد مناسب عملCPUکدامیک از بخشهاي -114

  Cache)د   Register)ج   Alu)ب*   CU)الف  
  تقسیم می شود؟......هر شیار به چند واحد کوچکتر به نام -115

  شیار)د     دیسک)ج     قطاع)ب*    سیلندر)الف  
   نادرست است؟Cacheکدامیک از موارد زیر درباره حافظه نهان-116

    Ram و حافظهCPuبینCacheحافظه)الف  
.یردگقرار می Cacheدر داخل Cpuبه   در خواست می کند پاسخ این در خواست پیش از ارسال Ramاطلاعاتی را از Cpuهنگامی که )ب

    .میباشدRAmکمتر از Cacheسرعت دستیابی به اطلاعات )ج*  
  .از عوامل موثر در کارائی سیستم میباشدCacheمقدار حافظه)د  

  نمی باشد؟CPu ز واحد هاي کدامیک از بخشهاي زیر ج-117
  Secondary memotr)د*    ثبات یا ریجستر)ج   CU)ب     ALU)الف   

  کدامیک از حافظه هاي فقط خواندنی زیر قابل برنامه ریزي و پاك شدن توسط جریان الکتریسته می باشد؟-118
  Ram)د  Eeprom)ج*    Rom)ب  Prom)الف   

   می شوند چه نام دارد؟کوچکترین عنصري که تصاویر از آن تشکیل-119
  اینج)د    پیکسل)ج*      بایت)ب      بیت)الف   

  نامیده می شوند؟.....د که ناطلاعات در روي دیسکها بر روي شیارهایی ذخیره می شو-120
  قطاع)د     سیلندر)ج    تراك)ب*    سکتور)الف   

  ق می شود؟به اجزا مختلفی که با هماهنگی کار می کنند وهدف واحدي را دنبال میکنند اطلا-121
  System)د*  Hardware)ج  Software)ب  Program)الف   

  ظرفیت کدام یک از حافظه هاي زیر بیشتر است؟-122
 CD-ROM)ج    فلاپی دیسک)ج    DVD)ب   دیسک سخت)الف*  

  اطلاعات کدام یک از حافظه ها با اشعه ماورا بنفش پاك می گردد؟-123
 Eprom)د*   sram)ج  Eeprom)ب  prom)الف  

  چاپگر لیزري جزء کدام دسته از چاپگرها می باشد؟-124
  مکانیکی)د     حرارتی)ج    غیر ضربه اي)ب*    ضربه اي )الف  

   به کدام حافظه منتقل می شود ؟CPU اطلاعات بعد از پردازش توسط – 125
  CD-ROM)  د    فلاپی دیسک ) ج    RAM) ب*    هارد دیسک) الف  

  ستند؟ قلم نوري و موس چه دستگاههایی ه-126
   خروجی-ورودي) د   ورودي -ورودي) ج*   ورودي -خروجی) ب   خروجی -خروجی) الف  

   محتواي کدام یک از حافظه هاي زیر با قطع جریان برق پاك می شود؟-127
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    EPROM) د      RAM) ج*     PROM) ب     ROM) الف  
     یک برنامه به منظور اجرا در کدام حافظه قرار می گیرد؟-128

  فلاپی دیسک  ) د    دیسک سخت ) ج     Ram) ب*     Rom) الف  
  گفته می شود؟.… بیت مجاور هم که یکی از علائم یا اعداد یا حروف را نمایش می دهد8 به مجموعه -129

   Bit) د      Byte) ج*      Word)ب      File) الف  
  کدام گزینه کامپیوتر کیفی است؟-130

  Main Frame )د  Desktopکامپیوتر )ج    Notebook)ب*     Pc)الف  
   کدامیک از کامپیوترهاي زیر از نظر پردازش قوي تر است ؟ -131

  Mini Computer)د    Laptop) ج      PC) ب  Mainframe)الف *   
  .کدام زبان برنامه نویسی براي اجرا احتیاج ترجمه ندارد-132

  Cobolزبان ) د    زبان اسمبلی)ج    زبان ماشین) ب*    بیسیک ) الف  
  ئم بالایی در صفحه کلید از کدام کلید استفاده می شود؟براي تایپ علا-133

   Space)د      Alt)ج       Ctrl)ب    Shift) الف*  
  ؟کدام چاپگر ضربه اي است-134

  حرارتی)د    جوهر افشان)ج     لیزري)ب  ماتریس نقطه اي)الف*  
  چیست؟ROM,RAM فرق حافظه -135

  .فقط نوشتنی است RAMفقط خواندنی است ولی  ROM) ب   .از نوع مغناطیسی است ROM از نوع نیمه هادي و RAM) الف  
  هیچکدام ) د      خواندنی ونوشتنی است RAMفقط خواندنی است ولی ROM) ج*  

  است؟............  رسام نوعی وسیله -136
  حافظه) د         ورودي و خروجی) ج خروجی                    ) ب*  ورودي                )الف  

  م حافظه قابل پاك شدن نمی باشد؟ کدا-137
  نوار مغناطیسی)د    Cd Rom)ج*   Floppy Disk) ب    Hard Disk) الف  

مهمترین نرم افزار روي هر سیستم که وظیفه مدیریت و کنترل و ایجاد ارتباط بـین نـرم افـزارو سـخت افـزار و کـاربر را دارد چـه نـام دارد؟                 -138
  سیستم عامل)د*  امه نویسیزبان برن)ج      Cpu)ب    برنامه مترجم)الف  

  کدامیک از دستگاههاي زیر فقط خروجی است؟-139
  ماوس)د    دیسکت)ج      اسکنر)ب    مانیتور)الف*  

  کدام یک از دستگاه هاي زیر جهت انتقال تصاویر به کامپیوتر به کار می رود؟-140
  ماوس)د    صفحه کلید)ج      پلاتر)ب    اسکنر)الف*  

  ز نرم افزارها می باشد؟سیستم عامل جزء کدام دسته ا-141
  برنامه نویسی)د    سیستمی)ج*     مترجم)ب    کاربردي)الف  

  از صفحه کلید را فشرد؟. ………براي انصراف از ادامه عملیات باید کلید -142
  Caps Lock)د    Back Space)ج    Space) ب       Esc)الف*  

  ویندوزسوالات 
  رتب می کند؟روي هم م کدام گزینه پنجره ها را به صورت آبشاري و-1

 Tile Windows Horizontally )ب      Tile Windows Vertically)الف  
 Show Minimize AII Windows)د      Cascade Windows)ج*  

  جهت نمایش فایلهایی که به علت فضاي کم پنجره دیده نمی شوند از چه نواري استفاده می شود؟-2
 Address Bar)            دScroll Bar)ج*               Menu Bar)ب           Status Bar )الف  

  کدام گزینه صحیح است؟Task Barجهت قفل نمودن -3
  Lock The Task Bar انتخاب)ب*    Auto Hide The Task Barانتخاب)الف  
  Auto Hide The Task Barعدم انتخاب)د    lock The Task Barعدم انتخاب)ج  
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  ترکیبی می توان استفاده کرد؟براي بستن فایل جاري از کدام کلیدهاي -4
 ALT+F2)              دSHIFT+F2)ج            ALT+F4)ب*         SHIFT+F4)الف  

  چه بایدکرد؟ بگیرد براي این که کامپیوتر درحالت استراحت قرار-5
  .  را انتخاب می کنیمStand By گزینه Turn Off Computerاز پنجره ) الف*  
  .  را انتخاب می کنیمTurn Off گزینه Turn Off Computerاز پنجره ) ب  
  .  را انتخاب می کنیمRestart گزینه Turn Off Computerاز پنجره ) ج  
  .  را انتخاب می کنیمLog Off گزینه Log Offاز پنجره ) د  

   تنظیمات پوشه ها در کدام قسمت امکان پذیر است؟ -6
  Folder Option) د*    Folder Properties) ج     Tools) ب    Folder Type) الف  

   از کدام گزینه استفاده می شود؟ Recycle Bin جهت بازیابی اطلاعات حذف شده -7
  Restore) د*     Empty) ج     Undelete) ب   Shift + Del) الف  

   به نوار پایین دسک تاپ چه می گویند؟  -8
  Status bar) د     Scrollbar) ج     Toolbar) ب    Taskbar) الف*  

   براي حذف محتویات سطل بازیافت از کدام دستور می توان استفاده کرد؟-9
  Format) د   Erase) ج    Restore) ب  Empty Recycle bin) الف*  

   به چه منظوري استفاده می شود؟ Type  Arrange Icon By / گزینه-10
  س اندازه آنها مرتب کردن آیکن ها براسا) ب      ردن آیکن ها براساس نام آنها مرتب ک) الف  
  مرتب کردن آیکن ها براساس تاریخ تایپ شده) د      آیکن ها براساس نوع آنها مرتب کردن ) ج*  

  . آیکن برنامه باعث چه رخدادي می شود رويدوبار کلیک بر-11
  اجراي برنامه)د*  باز شدن منوي میانبر   )ج  بسته شدن برنامه    )ب  انتخاب آیکن برنامه   )الف  

  .نگر چیستا نمای،ایلپسوند ف-12
  حجم فایل) د    نام فایل          )ج  اندازه فایل        )ب  نوع فایل        )الف*  

  .ها از کدام گزینه استفاده می کنیمه براي حذف دائمی فایلها وپوش-13
  Ctrl+Del)    دDelete)       جRecycle binکشیدن وانداختن در)ب      Shift+DeL)الف*  

  . گزینه هاي زیر تعریف ویروس استکدامیک از-14
  .به هر نوع برنامه مخرب گفته می شود)ب    .ه مخفیانه وارد رایانه می شودبرنامه ي کوچکی ک)الف  
  .برنامه ي مخرب کوچکی که مخفیانه وارد رایانه می شود)د*    .برنامه اي که به اطلاعات رایانه آسیب می رساند)ج  

  .کدام دستور استفاده می شوداز  براي تنظیمات صفحه ي کاغذ-15
  Page setup)د*                 Print)ج               Send)ب        Print preview)الف  

  .انتخاب می کنیم را .......... پیش فرض گزینه ي براي تعیین چاپگر-16
  Set as device)     دset as default printer)ج*     Local Printerset as)ب          Add Printerَ(الف  

  .تاریخ فعلی رایانه در کدام قسمت از محیط میز کار ویندوز می باشد ساعت و-17
  دکمه ي شروع)د امه هاي الحاق شده     برن)برنامه هاي در حال اجرا    ج)ناحیه تذکر                 ب)الف*  

  .می کنیماستفاده  هاي میانبر ازکدام کلیدTask Manager براي کار با پنجره ي-18
  Ctrl+Alt+F8)د       Ctrl+Alt+delete)ج*        Ctrl+Alt+lnsert)ب       Ctrl+Alt+F2)الف  

  .انتخاب نمود arrange icons از منوي باید کدام مورد را.براي این که آیکن ها همیشه به طور مرتب قرار گیرند-19
  Auto arrange)د*           By type)ج                By date)ب          By name)         الف

  ،باید چه عبارتی را جست وجوکنیم؟ اگر بخواهیم دقیقا عبارت سازمان فنی وحرفه اي کشور رادررایانه بیابیم-20
  *سازمان فنی وحرفه اي کشور)* ب       "سازمان فنی وحرفه اي کشور")الف*  
  کشور؟؟؟؟سازمان فنی وحرفه اي )د       ؟سازمان فنی وحرفه اي کشور؟)ج  

  .است...........به صورت)به صورت پیش فرض بدون نصب نرم افزارجانبی(پسوند فایلهاي فشرده شده در ویندوز-21
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  .ir)د                com.)ج   .             zip)ب*                 rar)الف  
 :محلی براي نگهداري ودسته بندي فایلها و پو شه ها -22

  FOLDER-د*   MY DOCUMENT -ج    WINDOWS EXPLORER-ب      MY COMPUTER -الف  
 براي اجراي یک برنامه از طریق آیکون آن ، از کدام گزینه زیر استفاده می شود ؟-23

   ازمنوي مربوطهOPEN انتخاب -ب*     FORMAT ازمنوي OPEN انتخاب -الف  
  هیچکدام -د       EDIT ازمنوي OPEN انتخاب -ج  

 .شده بر روي فایلها و پوشه ها و برگشتن به حالت قبل کدام گزینه را انتخاب می نماییم براي لغو آخرین عمل انجام -24

   REDO-د     UNDO-ج*     CLOSE -ب     RESTORE -الف  
 فایلهایی که حذف می شوند در کدام محل نگهداري می شوند ؟-25

   BIOS-د RAMدر حافظه موقت -ج   RECYLE BIN -ب*   CLIP BOARD -الف  
  قرار دارد؟PROPERTIS در کدام یک از سربرگهاي پنجره WAITگزینه -26

   SCREENSAVER -د*    APPEARANCE -ج                  THEMES -ب   BACK GROUND-الف  
  پسوند فایل هاي متنی ، کدام است ؟ -27

   TXT-د*       PPT-ج       XLS-ب      BMP -الف  
   چه می باشد ؟DIALOG BOXمنظور از  -28

   نوار کار -د     میز کار -ج   کادر محاوره اي -ب*      پنجره-لفا  
  چگونه می توان عمل نمود ؟ PRINTERبراي  توقف چاپ تمامی  اسناد که در صف چاپ قراردارد در پنجره  -29

  .  کلیک می کنیم CANCEL بر روي گزینه DOCUMENT  از منوي -الف*  
  کنیمکلیک می  PAUSE بر روي گزینه DOCUMENT  از منوي -ب  
  نمیتوان این عمل را انجام داد)د  .  را کلیک می کنیمCANCEL ALL DOCUMENT   گزینهPRINTER  از منوي -ج  

  می گردد؟DESKTOPکدام انتخاب از گزینه هاي روش مرتب سازي باعث نمایش یا مخفی شدن آیکن ها بر روي  -30

     MODIFIED-د   SHOW DESKTOP ICONS -ج*    AUTO ARRANGE -ب    ALIGN TO GRID -الف  
  قرار می گیرد ؟ DESK TOPدر کدام ناحیه از نوار وظیفه دکمه هایی براي برنامه هاي باز روي  -31

    SCROLL BAR-د   SYSTEM TRAY -ج*     TOOL BAR -ب   TASK MAN GER -الف  
 کدام درایو ، درایو منطقی است ؟ -32

  دیسک فشرده -د      هارد دیسک-ج    فلاپی دیسک-ب     E درایو -الف*  
 براي انتخاب غیر متوالی  آیکن ها کدام کلید را پایین نگه می داریم ؟ -33

   SPACE-د     SHEFT-ج    ALT-ب     CTRL -الف*  
  هنگام جستجوي فایلی که کلمه اي از محتواي آن را می دانیم این کلمه در کدام قسمت تایپ می شود ؟SEARCHدر برنامه -34

   LOOKIN-ب      ALL OR PART OF THE FILE NAME -الف  
   TYPE – MODIFIED-د      A WORD OR PHRASE IN THE FILE-ج*  

 براي مرتب سازي براساس نوع و تاریخ ویرایش به ترتیب از راست به چپ کدام فرمان ها را باید از منوي میانبر انتخاب نمود ؟-35

 TYPE-MODIFIED -د  DATE, MODIFIED-ج    MODIFIED –TYPE -ب*    TYPE –DATE -الف  

  کدام گزینه زیرکامپیوتر را در حالت آماده باش قرار می دهد؟-36
   Restart in MS-DOS mode) د   stand by) ج* Restart) ب   shut down) الف   

  جا نمود؟ه  پنجره را جاب، چگونه می توان توسط ماوس-37
  بزرگ نمودن پنجره ) د  کوچک نمودن پنجره ) ج  نوي پنجره باکشیدن نوار م) ب  با کشیدن نوارعنوان پنجره ) الف*   

   می گویند؟…………… ، به نوار رنگی بالاي هر پنجره-38
   Task Manager) د   Quick Lanuch) ج  نوار ابزار ) ب    نوار عنوان ) الف*   

  د؟ تصاویر کوچک گرافیکی در سمت چپ محیط کار ویندوز که شامل پوشه ها، برنامه ها می باش-39
   Icon) د*  Start) ج    File) ب     Folder) الف   
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   نواري که منوي کنترل روي آن قرار دارد چه نامیده می شود؟-40
  menu bar) د  status bar) ج        title bar) ب* Tool bar) الف   

   کدام روش استفاده می گردد؟عمودي به صورت ،جهت نمایش پنجره هاي باز ویندوز -41
   Tile Windows Horizontally) ب     Cascade Windows) الف   
  Minimize All Window) د     Tile Windows Vertically) ج*   

   ولی پنجره را نمی بندد؟،انتخاب کدامیک از دکمه هاي زیر تغییرات را در پنجره اعمال -42
   Add) د      Cancel) ج      Apply) ب *      Ok) الف   

  گردد؟ زیر انتخاب می Arrange Iconsدن فایلها از روي اندازه به ترتیب صعودي کدام یک از گزینه هاي منوي به منظور مرتب نمو -43
  Date) د      Type) ج      Size) ب*       Name) الف   

  می شوند؟ ها وپوشه ها از روي تاریخ ایجاد در پنجره مرتب با انتخاب این گزینه فایل -44
  Date) د*     Type) ج              Size )ب       Name) الف   

   صفحه اصلی ویندوز چه نام دارد؟-45
 Desktop )د *    My Computer )ج    My Document )ب         Folder )الف    

  را مشاهده کرد ؟........  بعداز انتخاب فایل درکدام بخش از پنجره می توان مشخصات فایل ازقبیل ظرفیت، تاریخ ساخت و-46
   System info)  د              Other Places) ج     Folder tasks)            بDetails) الف*   

  حداکثر چند کاراکتر می تواند باشد؟Windows نام فایل در -47
  محدودیت ندارد)           د    8) ج       256)  ب*       11) الف   

  ک را داشت از کدام گزینه استفاده می شود؟ در نمایش آیکن ها به طوري که بتوان نمایش یک آیکن تصویري کوچ-48
  List) د  Thumbnails) ج*   Icon) ب  Tiles) الف  

   کدام یک از کلیدهاي زیر استفاده می شود؟،جهت انتخاب تعدادي فایل پشت سرهم -49
  Alt) د     Space) ج    Ctrl) ب     Shift) الف*   

  لاعات زیر نمایش داده نمی شود؟ ازخصوصیات درایو کدام یک از اطGeneralدر برگه  -50
  نمودار دایره اي درایو) ب    گنجایش فضاي پر و خالی درایو) الف   
  برچسب درایو که می توان آن را تغییر داد) د    ها وپوشه هاي درایو تعداد فایل) ج*   

  رکیبی است؟ معادل فشردن کدام یک از کلیدهاي تEdit از منوي Cut ، انتخاب گزینه Explorerدر پنجره  -51
   Ctrl+Q) د     Ctrl+V) ج   Ctrl+X) ب*     Ctrl+C) الف   

  ؟شوداجرا باید  Desktp کدام یک از آیکن هاي ،ها وپوشه هاي حذف شده جهت بازیابی فایل -52
     My Document) ب         My Computer) الف  
  Outlook Express) د         Recycle Bin) ج*  

  گردد؟ یمي متنی در ویندوز،کدام یک ازبرنامه هاي زیر استفاده ها ویرایش فایل جهت ایجاد و -53
   Sound Recorder) د         Imaging) ج    Paint) ب        Wordpad) الف*  

   ؟  تغییرنام فایل یا پوشه ها در ویندوز، از کدام کلید تابعی استفاده می شود براي -54
  F2) د*                   F3) ج            F1) ب                       F5 )الف  

   ؟  ، از کدام کلید تابعی استفاده می شود(Help)اجراي راهنماي ویندوزبراي  -55
  F2) د                   F3) ج            F1) ب*                       F5 )الف  

  را انتخاب می کنیم ؟............ ه و گزینه  براي اینکه یک آیکن میان بر از یک برنامه داشته باشیم، روي آن کلیک راست کرد-56
  هیچکدام)           د  Send To) ج*    Copy)  ب          Cut) الف  

   ترکیب کدام کلیدها می باشد ؟ ، Edit از منوي  Copyمعادل عمل  -57
    Ctrl + Z)د             Ctrl + C) ج*      Ctrl + X) ب       Alt + F4) الف    

   نمایش می دهد؟My Computer در نوار ابزار ساختار درختی را در پنجره  کدام دکمه-58
  Folder Option)د               View) ج   Folder) ب*   Up) الف  
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   کدام دستور براي حذف فایل ها ي موقت و غیر ضروري موجود به کار می رود ؟-59
  Remove) د    Copy disk) ج  Format) ب  Disk Cleanup ) الف*  

 . از چه کلیدي استفاده میکنیم WORDPADجهت انتقال مکان نما به ابتداي سطر جاري در محیط متنی -60

   PAGE UP-د     INSERT-ج     END -ب    HOME -الف*  
   براي از بین بردن اثرآخرین عمل انجام شده چگونه باید عمل نمود ؟-61

  Forward) د     Back) ج    Undo) ب*    Up) الف  
   کدام یک از موارد زیر است؟paste گزینه  کلید میان بر-62

  Ctrl +V) د*   Ctrl +F) ج   Ctrl +X) ب Ctrl +c) الف  
   از فرمان جستجو کدام یک از اطلاعات زیر وارد می شود؟Look Inدرقسمت  -63

  متن موردنظر در محتواي فایل) ب    هاي خاص موردنظر جهت جستجو  مکان) الف   
  اندازه فایل برحسب کیلو بایت) د      ردنظر یا پوشه مو نام فایل و) ج*   

 باشندکدام گزینه راانتخاب می نماییم؟ Gtgحرفی بوده وبا پسوند6براي جستجوتمام فایلهایی که -64

 Gtg.6)د  Gtg.?*?)ج   Gtg.??????)ب* Gtg.*)الف  

  کار می رود؟ دارند به TXT بوده و پسوند E کدام گزینه براي جستجوي فایل هایی که حرف دوم آنها -65
  E.TXT*) د    E*.TXT?) ج*      E?.TXT?) ب    E*.TXT*) الف   

    جهت انتخاب ظرفیت دیسک مورد نظر از کدام کادر استفاده می شود ؟ Format در دستور -66
    volume label)                  د Capacity) ج*    Quick format)        ب File system) الف   

   باعث می شودتا فرمت سریع تر انجام شود؟Format گزینه در  انتخاب کدام-67
  Type Format)   د       copy system File)  ج  Full)     ب Quick) الف*   

   کدام گزینه را فعال می کنیم ؟Print جهت چاپ صفحه جاري در پنجره -68
      Collate ) د              Select Page)          جCurrent Page) ب*                  All)  الف   

   از کدام کلید استفاده می شود؟WordPad براي ایجاد یک سطر جدید در برنامه -69
  Enter) د            * Back space) ج  Space bar)      ب Tab) الف   

  از کدام گزینه استفاده می شود؟XP براي دسترسی به راهنماي ویندوز -70
 Start/Help And support) ب*         Start/Help) الف  

  Start/All program/ Help And support) د          Start/All program/Help) ج  
   فهرست الفبایی موضوعات راهنما در سمت چپ آن مشاهده می شود؟Help در کدام یک از سربرگ هاي پنجره -71

  Display )     د            Content) ج    Index) ب*            Search) الف   
   براي ذخیره فایل با نام جدید از کدام گزینه زیر استفاده می شود Wordpadدر -72

 Save As)د*    New)ج    Open)ب    Save)الف   

  کدام کلید میانبر زیر براي زیرخط دار کردن متن بکار می رود-73
  Ctrl+Z)د  Ctrl+U)ج*    Ctrl+I)ب  Ctrl+B)الف   

  ي چاپ به صورت افقی بکار می رودکدام گزینه زیر برا-74
 Landscape)د*  Margins)ج    Portrait)ب  Orientation)الف   

   کدام گزینه زیر فایلهایی که ظرفیت حداقل یک مگا بایت دارند را جستجو می کند-75
 Large (More Then 1 MB))ب*  Medium(Less Then 1 MB))الف  

 Don't Remember)د  Small(Less Then 1024KB))ج  

  کدام قسمت از نوار وظیفه براي نمایش دکمه هاي پنجره باز شده بکار می رود؟-76
  هیچکدام)د  Toolbar)ج   System Tray)ب Task Manager)الف*  

  ........دوبار کلیک بر روي آیکن برنامه باعث -77
  انتخاب آیکن برنامه می شود)ب  اجراي آن برنامه می شود)الف*   
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  بسته شدن برنامه می شود)د  یان برمی شودباز شدن منوي م)ج   
  باعث می شود تا نوار وظیفه همیشه روي سایر پنجره ها قرار بگیرد؟task bar and start menu انتخاب کدام گزینه از کادر محاوره اي -78

 Auto-hide the task bar)ب     Lock the taskbar)الف   

  show the quick lanuch)د  Keep the task bar on top of the whndow)ج*  
  انتخاب همه فایلها و پوشه ها از طریق کدام منو قابل انجام است؟-79

  Screen saver)د  Setting)ج  Ebit)ب*  View)الف   
  استفاده می کنیم؟Display propeties براي تغییر تعداد پیکسل ها از کدام سربرگ کادر محاوره اي -80

  screen saver)د  Setting)ج*  desktop)ب Appearance)الف  
  ......و در حذف فیزیکی فایل حذف شده......در حذف منطقی فایل حذف شده -81

  به صورت کامل انجام میشود-منتقل میشود recycle binبه پوشه )الف*  
  منتقل می شودreceycle binبه پوشه -به صورت کامل حذف می شود)ب

   منتقل می شودreceyclebinبه پوشه -ود منتقل می شreceycle binبه پوشه )ج  
  به صورت کامل حذف می شود-به صورت کامل حذف می شود)د  

  یکی از مهمترین علائم جانشینی که می تواند به تنهایی جانشین یک یا چند کاراکتر شود،چه نام دارد؟-82
  $)د    ؟)ج    )!ب    )*الف*  

  انه چیست؟ بر روي نوار قالب بندي نشu،نمادword padدر محیط -83
  سایه دار بودن قلم) د مورب کردن قلم )ج  زیر خط دار کردن قلم)ب*  پر رنگ کردن قلم)الف  

،فعال بودن کدام عبارت باعث می شود که جستجو بین حروف کوچک و بزرگ find در پنجره word padدر هنگام جستجوي کلمات در -84
  تفاوت قائل شود؟

 find what)د find next)ج match whole word only)ب Match case)الف*  

  براي انتخاب چابگر پیش فرض کدام فرمان به کار می رود؟-85
  Addprinter)د Cancel printer)ج set as default printer)ب* Pause printing)الف  

  براي محتویات حافظه موقت چه اتفاقی می افتد؟paste پس از اجرا ي دستور -86
  تقل می شوند و از کلیپ برد حذف می شودبه محل مورد نظر من)الف  
  تغییر نمی کندهمچنان  کپی موضوع بعدي دردر حافظه موقت باقی می ماند و )ب  
  ن در محل مورد نظر ارسال می شودآمحتویات حافظه موقت تغییر نمی کند بلکه کپی )ج*  
  .محتویات حافظه موقت حذف شده و یا با موضوع جدید جایگزین میگردد)د  

  باشد را جستجو می کند؟A ام گزینه فقط فایلهایی را که حرف دوم نام آنها کد-89
   *.*A?)د*    *.Aَ*)ج  ?*A)ب    ؟A* .)الف  

  می شود؟.... اکر محتویات پنجره در اندازه جاري پنجره جا نگیرد باعث ظاهر شدن -90
 Tool bar)د  Address bar)ج  Scroll bar)ب*  Status bar)الف  

   گزینه هاي زیر رنگ و اندازه قسمتهاي مختلف را تغییر می دهد؟کدام یک از-91
  Appearance)د*  Setting)ج Screen saver)ب  Baground)الف  

  با کدام گزینه می توان برنامه محافظ صفحه نمایش را قبل از انتخاب مشاهده کرد؟-92
 Effects)د  Preview)ج*   Wait)ب  Setting)الف  

  نجره ها از چه طریق عمل می کنیم؟براي حرکت دادن پ-93
 moveاستفاده از آیکن کنترل پنجره و انتخاب گزینه )ب       *  control panelاستفاده از )الف  

  moveو انتخاب گزینهcontrol panelاستفاده از )د minimaizeوmaximizeاستفاده از )ج 
  وظیفه تبدیل می کند؟ منوي پنجره را یک دکمه کوچک بر روي نوار کدام گزینه زیر-94

  maximaize)د  minimize)ج* move)ب   size)الف  
  ؟قسمتی از متن فایل را وارد کرد در کدامیک از لیستهاي زیر می توان -95
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   Lookin) ب     All Or Part Of The File Name) الف  
  Containing Text) د    A word or phrase in the file) ج*  

  ، از کدام گزینه زیر استفاده می شود ؟ آیکنها را به شکل کاشیکاري دیدریکه بتوان نمایش در نمایش آیکنها بطو-96
  List)د             Thumbnails)ج         Icon) ب      Tiles)الف*  

   در چه مسیري برنامه هاي نقاشی و واژه پرداز وجود دارد– 97
     Start/All Programs /System Tools )ب             Start/All Programs /Accessories )الف *  
 Start/All Programs /Games )د       Start/All Programs /Accessories/Entertainment )ج   

   براي مرتب سازي آیکن ها بر حسب پسوند از منوي میان بر  کدام مورد را انتخاب می کنیم ؟-98
  Type) د*      Size )ج        Date ) ب      Name ) الف  

   به حداقل می رسند؟تمام پنجره هاي بازبا کدامیک از گزینه هاي زیر-99
    Toolbars) ب          Cascade) الف  
  Tile Windows Horizontally) د      Show The Desktop) ج*  

   جهت ایجاد یک پوشه در ویندوز کدام گزینه صحیح است ؟ -100
  File→New→Folder) ب *       File→New→Text Document) الف   
  Edit →New→Folder) د        Edit→New→Text Document) ج   

   ؟نمی باشدکدام گزینه براي تغییر نام پوشه صحیح -101
   را انتخاب می کنیم  Rename گزینۀ  Editاز منوي ) ب*      Renameکلیک راست روي پوشه و انتخاب گزینۀ ) الف  
  F2انتخاب پوشه وسپس فشردن کلید ) د    انتخاب پوشه و سپس کلیک روي نام پوشۀ مورد نظر ) ج  

   چگونه می توان توسط ماوس پنجره را جابجا نمود؟-102
   نوار منوي پنجره دراگ کردن رويبا) ب       نوارعنوان پنجره دراگ کردن رويبا ) الف*  
   پنجرهابزار نواردراگ کردن رويبا ) د       پنجره آدرس نواردراگ کردن رويبا ) ج  

   در ویندوز کدام گزینه صحیح است ؟ یک فایل متنیبراي ایجاد  -103
  File→New→Folder) ب        File→New→Text Document) الف   
  Edit →New→Folder) د        Edit→New→Text Document) ج *  

  اینترنتسوالات 
  شرکتهاي ارائه دهنده خدمات اینترنت چه نام دارد؟-1

 Mcp)د  Aol)ج  Isp)ب*   Icp)الف  

  می گویند؟ .................................. خانگی یک وب سایت را  صفحه -2
  Current page) د    Web page)ج    Home Page) ب*     First Page) الف  

   نامه هاي ارسال شده در کدام پوشه نگهداري می شود؟-3
  Inbox) د     Outbox) ج*       Trash) ب       Draft) الف  

شبکه بتوانیم از صفحاتی که قبلاَ در زمان اتصال به شبکه استفاده شده اند استفاده نمود از کدام گزینه استفاده           براي اینکه بدون اتصال به -4
  می کنیم؟ 

  Option) د   Work Offline) ج*       Favorites) ب       History) الف  
   نام دیگر آدرس وب سایت چیست؟ -5

  URL) د*    RLU) ج         ID) ب       ISP) الف  
   قسمت نوشت؟ کدامباید در، به چند دریافت کننده بطوریکه سایر دریافت کنندگان از وجود هم مطلع نشوند E – Mail براي ارسال -6

  Subject) د       TO) ج       BCC) ب*       CC) الف  
7-domain  در آدرس E-mail نشانه چیست؟  

  نام فایل مورد نظر)د  جهانی گستر وب    صفحه)ج    نام سرویس دهنده پست الکترونیکی)ب*  نام کاربر)  الف  
  چگونه می توان یک آدرس ایمیل را از آدرس وب سایت تشخیص داد؟-8
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  /وجود علامت )د    نام سرور)ج    عدم وجود نوع سرویس دهنده)ب  @وجود علامت )الف*  
  کدام گزینه یک موتور جستجوگر میباشد؟-9

 TVTO)د   find)ج    Google)ب*      search)الف  
  براي مشاهده ومرور صفحات وب از کدام برنامه زیر استفاده می شود؟-10

   Windows Explorer)ب    Internet Explorer)الف*  
 microsoft Outlook)د     Outlook Express)ج  

  براي پاسخ به نامه اي که به ما رسیده باید بر روي کدام دکمه کلیک کنیم؟-11
 New)د   Forward)ج    Reply)ب*  send)الف  

  .استفاده نمود........ در کنار کلمات می توان از+هنگام جستجو در موتور جستجو گر به جاي -12
 OR)د   AND)ج*  NOT)ب      " ")الف  

  براي قطع ارتباط با اینترنت از کدام گزینه استفاده می شود؟-13
 Eject)د   No connect)ج  connect)ب  Disconnect)الف*  

  م به چندین گیرنده در بین آدرس آنها از چه علامتی استفاده می شود؟ارسال یک پیا-14

  ) /                         د. )        ج,     )ب*   >)الف  
  براي ذخیره عکس از یک صفحه اینترنتی کدام یک از اعمال زیر را می توان انجام داد؟-15

   را می زنیمcutودر محل مورد نظر گزینه copy گزینه fileاز منوي )الف  
   را می زنیمAs save picture روي عکس راست کلیک کرده و گزینه)ب*  
   را می زنیمsave as pictureگزینه Toolsاز منوي )ج  
   را می زنیم ctrl+ x و در محل مورد نظر کلیدهايcopyروي عکس راست کلیک کرده گزینه )د  

  استفاده می شود؟internet option یک اززبانه هاي پنجرهبراي پنهان کردن نمایش تصاویردرصفحه وب از کدام-16
  Connect) د            Security)ج          Advanced)ب*                General)الف  

  . در اینترنت چه نامیده می شودپروتکل-17
  Connect)               دSecurity)         جHttps)ب*            url)الف  

  رم افزارهاي زیر مرورگرصفحات وب نیست؟کدام یک از ن-18
  Mozilla Fire fox)            دWindows explorer)ج*  Netscape)            بInternet explorer)الف  

  .کلیک نمودIE براي برگشتن به صفحه ي قبلی ملاحضه شده روي کدام دکمه باید در-19
  Home)          دBack)ج*           Forward)              بRefresh)الف  

  کدام یک از گزینه هاي زیر به معنی پست الکترونیکی است؟-20
  E-commerce)د         E-mail)ج*  Chat)ب WWW)الف  

  .می گویند.........انتقال یک فایل از رایانه سرویس دهنده به رایانه خودمان را-21
  Download)د*         Move)              جUpload)               بLoad)الف  

  کدام یک از گزینه هاي زیریک آدرس صندوق پستی صحیح می باشد؟-22
  com.oovah.www(            alireza.com@vahoo)      جcom.ali@yahoo)             بir.irantvto@bavat)االف*  

  .پیغامهاي ناخواسته درصندوق پستی به چه نامی مشهورند-23
  ایمیل)           دVirus)          جSpam)ب*             Noise)الف  

  رپیام ظاهرمی شود؟ اگر نامه اي که ما رسیده داراي ضمینه باشدبه چه شکلی درکاد-24
  attachبه صورت نوشته ي بزرگ) ب      به صورت کلیپس     )الف*  
  attachبه صورت نوشته ي کوچک)د    به ضورت ستاره دارظاهرمی شود   )ج  
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  ...........  .شاملOutboxپوشه ي -25
  .ن ها تکمیل نشده استلیست نامه هاي است که هنوزفرایندارسال آ)ب         .لیست نامه ي دریافت شده است)الف  
  .لیست نامه هاي ارسال شده است)د*          .یست نامه هاي حذف شده استل)ج  

  .کدام گزینه مربوط به کتابچه ي آدرس است-26
  Book)            دFind)           جAddress)          بAddress book)الف*  

 کدام مورد یک مرورگر صفحات وب نیست ؟-27

    OUTLOOK EXPRESS -ب*     INTERNET EXPLORER -الف  
  OPERA -د      MOZILA FIER FOX -ج  

 کدام یک از گزینه هاي زیر یک موتور جستجو است ؟-28

   OPERA-د     IE-ج     GOOGLE -ب*     FIRE FOX-الف  
   چه چیزي قرار می گیرد ؟ATTACHدر هنگام ارسال نامه در کادر  -29

   موضوع نامه -د    سایر مخاطبین -ج  ي ضمیمه فایل ها-ب*   مخاطب اصلی نامه -الف  
 )از راست به چپ( در یک فایل کدام گزینه صحیح است ؟WEB صفحهبراي ذخیره کردن  -30

  SAVE AS -  FILE-د*   SAVE AS-EDIT-ج     SAVE-FILE-ب   SAVe-EDIT -الف  
 د ؟ در جستجوي عبارتها کدام عملگر را می توان استفاده کر" – "به جاي علامت -31

   XOR-د     NOT-ج*     AND-ب    OR-الف  
 ذخیره یک فایل از کامپیوتر سرویس دهنده به کامپیوتر خودمان را چه می گویند ؟ - 32       

  Download-د*     MOVE-ج  Upload -ب  LOAD-الف  
 ه کدام گزینه زیر است ؟ نشان دهندMSN عبارت COM.MSN.WWW://HTTPدر آدرس  -33       

   نام صفحه وب که باید توسط مرور گر نشان داده شود -پروتکل      د-ج     Host-ب     Domain -الف*  
  با کدام برنامه امکان پذیر است ؟  Emailارسال ودریافت نامه هاي پست الکترونیکی  -34

  Printer-د      Msword -ج     Outlook Express -ب*    Windows Exploer -الف  
  می بایست ارائه شود؟  از شرکت ارائه دهنده سرویس اینترنت کدام یک از موارد زیرaccount درصورت گرفتن -35

  هر سه مورد) د*      ) password(کلمه رمز) ج  شماره تلفن محلی ) ب   )user name(نام کاربري ) الف  
  ی دهد؟کدام یک دامنه هاي زیر آموزشی  بودن سایت را نشان م -36

  net)د       org)ج     mil)ب     edu) الف*  
  می کنند؟ استفاده  ايدامنهچه موسسات تجاري از   سایتهاي تجاري،کمپانی ها، معمولاً-37

  gov)د       com)ج*    net) ب     edu) الف  
  می توان استفاده کرد؟ باشد از کدام کلیدهاي ترکیبی براي کامل کردن آدرس Com در صورتی که آدرس صفحات وب داراي پسوند -38

  Alt + Shift)د     Ctrl + Shift)        جShift + Enter)    ب Ctrl + Enter)الف*  
  می باشند....... .پسوند شامل فایلهایی با وب سایتها -39

  DAT)د    DOC)   ج     TXT)ب    HTML )الف*  
  ب در پنجره جداگانه اي باز   می شود ؟را موقع کلیک روي فراپیوند نگه داشته باشید صفحه و....  اگر کلید-40

  Enter)د      Alt)ج    Ctrl)ب    Shift)الف*  
  .مجموعه صفحات وب مرتبط به هم که روي یک کامپیوتر سرویس دهنده وب هستند ........ -41

 Internet  Explorer)د    Web Site)ج*        Home Page)ب  Web Page)الف  

  ن زیر خط داري که با کلیک بر روي آنها وارد یک صفحه دیگر می شویم چه می گویند ؟ بر روي یک صفحه وب به عناوی-42
   Connect) د    link) ج*        Favorites ) ب  Home page) الف  

  ..…ردد گمی  موجب،جهت ذخیره صفحات وبweb page compelete  ي انتخاب گزینه -43
    .  ایجاد گرددhtmlفایلی مستقل با پسوند ) ب       .یري ساخته شودپوشه اي پر از فایلهاي تصو  وhtmlیک فایل ) الف*  
  .فایل متنی با قالب بندي ذخیره گردد) د       .       فایل متنی بدون قالب بندي ذخیره گردد) ج  
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  . نمایش داده شده خواهد برد ي روي صفحهIEکه با اجراي صفحه آغازین  شما را به ... يدکمه -44
  Stop)د  Back)ج    Forward)ب   Home)الف*  

   مشاهده صفحاتی که بیشترین ملاقات شده بکارمی رود؟جهت ،Viewو از منوي  historyکادردرکدام گزینه -45
  by date)د     by site )ج          by most visited)بby order visit today    *)الف  

   :Web براي ذخیره یک صفحه -46
  Save As گزینه Editمنوي )      دSave گزینه Editمنوي ) ج      Save As گزینهFileمنوي )  ب*  Aves گزینه Fileمنوي ) الف  

   براي اضافه کردن آدرس صفحات دلخواه یا مطلوب از کدام منو در نوار منو استفاده می شود ؟-47
    File) د  View) ج      Tools) ب  Favorites) الف*  

   قابل استفاده است؟Favoritesرس صفحه وب جاري به ناحیه  کدام فرمان براي اضافه کردن اد-48
  Favorites واقع درمنوي Add to Favoritesفرمان )   ب  * Toolsواقع درمنوي Add to Favorites فرمان) الف  
  واقع در نوار ابزار استانداردHistory فرمان) د         Toolsواقع درمنوي Favorites فرمان ) ج  

   را با یک صفحه خالی نشان خواهد داد؟IE، انتخاب کدام یک از گزینه هاي زیر، internet option  يدرپنجره -49
  clear history)د       use default) ج       use blank) ب*    use curreent) الف  

 خواهد Web تصویري روي صفحه  زیر، موجب نمایش یا عدم نمایش فایلهايتب هاي، انتخاب کدام یک از internet optionي درپنجره  -50
  شد؟

  Security)د  Content)ج  Advavced)ب*   General)الف  
  ، انتخاب کدام یک از گزینه هاي زیر، صفحه وب جاري را به عنوان صفحه ي آغازین در نظر می گیرد؟Internet Option  درپنجره -51

  Clear History)   دUse Default)     ج Use Blank) ب  Use Curreent) الف*  
   گزینه اي که آدرس صفحات اخیراٌ ملاقات کرده را نگه داري می کند ؟-52

  History) د*    Favorites) ج    Address book) ب  Tools) الف  
  ؟دام منوي برنامه استفاده می کنیماز ک) History(آدرس هاي موجود در قسمت تاریخچه  براي حذفInternet explorer  در برنامه -53

    Edit) د    Favorites) ج    Tools) ب*   File) فال  
    استفاده می کنیم؟Internet Option جهت حذف آدرس هایی که قبلاً مرور کرده ایم از کدام دکمه پنجره -54

  Use Default)د    Clear History) ج*Delet Cookies   ) ب Delet File  ) الف  
  آید؟  به شمار نمی، سایتهاي مشهور خدمات جستجووکدام یک جز -55

  Intel)د*  Altavista)ج Google)ب    !Yahoo)الف  
  کنید؟ اگربخواهید صفحاتی را جست وجو کنید که حاوي یک واژه و فاقد واژه دیگر هستند، واژه ها را چگونه تایپ می -56

  .دهید قرار می +بین واژه ها عملگر ) ب    .دهید  قرار میAndبین واژه ها عملگر )الف  
  .دهید قرار می  -بین واژه ها عملگر ) د*    .دهید قرار می ORین واژه ها عملگر ب) ج  

  باشد را جستجو می کند ؟..........  بین کلمات مورد نظر هنگام جستجوي یک سایت صفحاتی که شامل AND استفاده از عملگر -57
  ن پذیر نیستامکا) د  هیچ یک از کلمات) یکی از کلمات      ج) ب   هر دو کلمه )  الف*  

  شود؟  زیر نوشته میکادرهاي در کدام یک از ،جهت ارسال یک کپی یا رونوشت نامه، آدرس مربوطه -58
  Bcc)د   CC)ج*  To)ب    Subject)الف  

  کند؟ کنند، نگهداري می  کدام پوشه نامه هایی که دیگران براي شما ارسال میOutlook expressدر نرم افزار  -59
  Sent items)د           Drafts)ج  Outbox)ب   Inbox)الف*  

  گیرند؟ نامه هایی که تاکنون ارسال نموده اید، قرار می،  کدام پوشه Outlook expressدر نرم افزار  -60
  Drafts)د         Outbox)ج            Inbox)ب  Sent items)الف*  

  .را کلیک می کنیم......نه ي گزیInsert براي درج امضا در نامه از منوي Outlook دربرنامه-61
  Hyperlink)د   Signatures )ج*  Picture)     بFile Attachment )الف  

  کند؟  هاي حذف شده را نگهداري میE-mailکدام یک از پوشه هاي زیر  -62
  Delete folder)د        Delete items)ج* Sent items)ب  Inbox)الف  
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  ک از گزینه هاي زیر وجود ندارد ؟ در پنجره ایجاد نامه جدید کدام ی-63
  Priority) د    Find) ج*    Attach) ب  Send) الف  

   براي ارسال یک نامه دریافت شده به اشخاص دیگر از کدام گزینه استفاده می شود ؟-64
   Replyall) د  Reply) ج    Forward) ب*  Send) الف  

  مشخصات نامه نشانه چیست ؟ علامت گیره کاغذ در کنار Outlook Express در برنامه -65
    ) شدهForward(نامه انتقال یافته ) ب    فایل ضمیمه نامه) الف*  
  نامه دریافت شده ) د      پاسخ نامه) ج  

   با انتخاب بخشی از متن یک نامه با چه فرمانی می توان این بخش را به نامه دیگر انتقال داد ؟-66
  Paste) د    Send) ج    Paste / Copy) ب    paste/ Cut  الف*  

   براي حذف یکی از نامه هاي دریافتی بعد از انتخاب، کدام گزینه را انتخاب می کنید؟-67
    Delete) د*    Clear) ج     Remove) ب  Clean )الف  

   کدام یک از گزینه هاي زیر در مورد آدرس یک پست الکترونیکی درست است؟-68
   مرکز سرویس دهنده@ه کاربرمشخص)  ب     مشخصه کاربر@مرکز سرویس دهنده) الف*  
  WWWمرکز سرویس دهنده@مشخصه کاربر)  د  WWW مشخصه کاربر@مرکز سرویس دهنده)  ج  

   از چه آیکنی  در نوار ابزار استفاده می شودOutlookجدید در E_ Mail براي ایجاد -69
  Create Mail) د*    Find)ج  Address)ب  Message )الف  

  ت بالا هستند با چه علامتی متمایز متمایز می شوند؟پیام هایی که داراي اولوی-70
  )%د    $)ج    )!ب*    ؟) الف  

   باید کدام گزینه را انتخاب کرد؟Address book براي اضافه کردن یک آدرس به -71
  New Mail -د   New Group -ج     New Contact -ب*     New Folder -الف  

   کدام گزینه را بایدبرگزید؟Address bookايبراي آدرس ه  براي ساختن یک فهرست جدید-72
  New Mil)  د New Group)         جNew Contact)    ب  New Folder) الف*  

   ،کدام فرمان زیرا اجرا می کندIE در نوارابزار ستاره دکمه -73
  History -         د  Favorites -ج*      Refresh - ب  Stop -الف  

  جستجو ي صفحات وب بکار می روند کدامند؟عملکردهاي منطقی که جهت -74
  And. Or)د*  or,if)ج  not,if)ب  If,no)الف  

  را ذخیره کنیم کدام نوع ذخیره سازي را در نظر می گیریم؟Webاگر بخواهیم فقط متنهاي صفحه -75
 Ewb archive,single file)ب Web Page complete)الف  

  Text file)د*  Web Page.html)ج 
  ک از علائم زیر در آدرسهاي پست الکتروتیک استفاده می شود؟کدامی-76

  WWW)د  &)ج  ©)ب  @)الف*  
  )از راست به چپ(انتقال می یابد؟....و پس از ارسال به پوشه ......هر گاه نامه اي را ارسال نماییم ابتدا در پوشه -77

  draf- sent item)د Outbox- draft)  ج sent item-out box)ب* out box-inbox)الف  
  استفاده می کند اما خصوصی است چه نام دارد؟tcp/ip شبکه اي که همانند شبکه اینترنت از پروتکل -78

  Man)د  Lan)ج   interanet)ب*    Man)الف  
  جهت ورود به صندوق پست الکترونیکی کدام گزینه را انتخاب می کنیم؟-79

  Sign load)د  Singn up)ج  Singn out)ب  Sign in)الف*  
  جهت ایجاد یک امضاء براي نامه خود از کدام منو استفاده می شود؟-80

  Edit)د  Signature)ج  Message)ب option/ tools)الف*  
   اگر بخواهیم جستجو طوري انجام شود که واژه هاي مورد جستجو در کنار هم قرار داشته باشند-81

  استفاده می کنیم ) "  "(ز علامت کوتیشن ا) ب*     بین آنها استفاده می کنیمAndاز عملگر )الف  
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    ٠١٢١-٢٢٢٣٧۵٧ درجھ دو                                          تلفن  ICDL   آموزشگاه رایانھ شمال                                         نمونھ سوال 

 ١٩                                صفحھ WWW.PCSC.IR WWW.ANDIKOLAEI.COM, شھریور ساختمان ارم                               ١٧آمل خ 
  

  هر سه مورد) د     بین آنها استفاده می کنیمOrاز عملگر ) ج  
  را وارد می کنیم........ شماره تلفن Phones Number در کادر Connection موقع ایجاد یک -82

  محل کار)د   منزل)ج    آموزشگاه) ب     ISP )الف*   
83- Httpست؟ در آدرس سایت براي چی  

  نام شبکه می باشد)د  یک پروتکل می باشد) ج*     می باشدIspنام مرکز) ب  نام سایت می باشد) الف   
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